Design Principles And Usability Heuristics

You can avoid common design pitfalls by
following these rules-of-thumb for design

You can inspect an interface for usability

problems by applying these same
principles

James Tam

Design Principles And Usability Heuristics

Heuristics are broad “rules of thumb” that describe features
of “usable” systems:
1) Heuristics can be used as a design guide before the system is built.
2) Heuristics can be used as an evaluation mechanism after the system
has been completed. The same principles can be used to “evaluate” a
system for usability problems

Becoming quite popular:
1. User involvement is not required.

2. Can be applied without a great deal of prior training or time (another
example of discount usability) yet it catches many design flaws.
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Design Principles And Usability Heuristics
(Advantages)

*A few general guidelines can correct for the majority of
usability problems

*Easily remembered, easily applied with modest effort
*A cheap and fast way to inspect a system

It can be conducted by people who are not usability experts

Design Principles And Usability Heuristics
(Weaknesses)

Principles are more or less at the motherhood level
*Can’t be treated as a simple checklist
* Subtleties involved in their use

* A very broad approach that may not cover specific situations
- Example:

Heuristics for many
collaborating users

Heuristics for a
single user

<7




1. Simple And Natural Dialogue

Avoid making the interaction unnecessarily complex
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1. Simple And Natural Dialogue

Match the user’s conceptual model

Match the users’ task in as natural a way as possible
* Minimize mapping between interface and task semantics
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1. Simple And Natural Dialogue

Menu or window? Which window?

Compuserve Information Manager
File Edit Services Mail Special Window Help
| — Services ‘

Telephone Access Numbers ‘

— Access Numbers & Logon ‘

United States and Canada
— United States and Canada
— CompuServe Network

List

|| ? List

List by:
State/Province
Area Code
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1. Simple And Natural Dialogue

Present exactly the information the user needs when it is
needed

e Less is more

- Less to learn, to get wrong, to distract...

*Remove or hide irrelevant or rarely needed information
- Competes with important information on screen

* Information should appear in natural order

- Order of accessing the information matches the user’s expectations
- Related information is graphically clustered

* Minimize or mitigate modes

*Use windows frugally

- Don’t make navigation and window management excessively complex

James Tam
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Good: Info in the same place
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2. Speak The User's Language

it ¥isual Basic

o] e |
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2. Speak The User’s LLanguage

Terminology based on users’ language for task

I E— = [« b oy

Account total = $50.00
Maximum withdrawal of $50
at this time.

Unable to complete operation!
Error code: 10225

s | S| se0 | m | am | 4160

Use meaningful mnemonics, icons, and abbreviations

+eg File / Save
- Ctrl+8S (abbreviation)
- AItFS (mnemonic for menu action)
- Open folder (tooltip icon)

Microsoft Py
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3. Minimize The User’s Memory Load

*Describe required the input format, use examples, provide
default inputs

*Promote recognition over recall

&l Document1 - Microsoft Word

Fls Edt View Insert Format Tooks Table Window Help

O ew... Chrl+M B I U ‘
7 2 open... o
Close I
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Save fs...
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Fage Setup...
[ print Preview
& print... Chrl+p

V Recognition
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
01010101

Remove
what?

home

profs

tamj

N

231_temp 231 www
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3. Minimize The User’s Memory Load

Small number of rules applied universally
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
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Remove
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3. Minimize The User’s Memory Load

Small number of rules applied universally

File
11110000
01010101

James Tam




4. Be Consistent

Consistency of effects
* Same words, commands, actions will always have the same effect in
equivalent situations
* Makes the system more predictable
*Reduces memory load

James Tam

4. Be Consistent

Consistency of language and graphics
 Same information/controls in same location on all screens / dialog boxes
forms follow boiler plate.
» Same visual appearance across the system (e.g. widgets).

= Are you sure

| Spell check paused

Delete file Do you wish 1o conlinue
spell chack?

| o5 | Ho ‘
Problem encountered L=
= iy = = Quit program e

Do you wish to debug? "
Quitting program. do you
want to save?

| no | Yes ‘

bt ®
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4. Be Consistent

These are labels with a
raised appearance.

Is it any surprise that
people try and click on
them?

Address:

Contact I

Cancc! ;J
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4. Be Consistent
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5. Provide Feedback

What is the program doing?

P

Cursor

Sending EINARY file grapdesnif (15517 bytes)

[ 6% |
10240: 233 Kbytesls: 002

Progress bar

Random graphic James Tam




5. Provide Feedback

/ What mode
am | in now?
FdinY

4

[ —
What did | How is the
select? system
interpreting
my actions?
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5. Provide feedback

Should be as specific as possible, based on user’s input

[~ soa LY _Ioix|

Saving file heuristics.ppt
in notes folder

Best within the context of the action

wherte the cursor shape i.ndcic;l
the cursor from an arrow to 2|

“busy” mode (Figure 11), at |

Word is gaving doc.doc;, (EEEEEEE
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5. Provide feedback

Multiple files being copied,
but feedback is file by file.

Mow installing files. please wait. ..
Writing: E:\DRAWLTASAMPLESAS-06-20.YLM

Percent Copied: 0% || | 100

Piess [Ezc] To Abort

Drawing Board LT

James Tam

5. Provide feedback

Feedback response time
* How users perceive delays

Delay Effect

0<= delay <= 0.1 seconds | Delay not noticed (system appears to operate
instantaneously).

0.1 <delay <=1 second | Delay noticed but train of thought remains
uninterrupted.

1 <delay <= 10 seconds | Train of thought interrupted but person can still
remain focused on the system. (Cursor)

Delay > 10 seconds Person wants to do something else while waiting for
the system. (Progress bar)

James Tam




6. Provide Clearly Marked Exits

o
)

James Tam

6. Provide Clearly Marked Exits

This doesn’t just mean providing an exit from the
program but the ability to ‘exit’ (take back) the current
action.

e Universal Undo/Redo
- e.g., <Ctrl>-<Z> and <Ctr]> <Y>

*Progress indicator & Interrupt
* Length operations

Transfer Status
Sendng BINARY fle grapdesn i (15517 bytes)

| 5% |

10240: 238 Kbes/s: 02
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6. Provide Clearly Marked Exits

This can apply even with systems that are written for
‘experts’
*Example: A text-based space simulation game
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6. Provide Clearly Marked Exits

do

insideGalaxy = isEmpty = withinRange = true;
System.out.print("Enter the destination row (0 —9): ");
row = Console.in.readInt();
System.out.print("Enter the destination column(0 — 9): ");
column = Console.in.readInt();
if ((row < 0) || (row > (Galaxy.SIZE-1)) || (column < 0) || (column > (Galaxy.SIZE-1)))
{
insideGalaxy = false;

System.out.println("You cannot move outside the galaxy"); Loop

}

hile ((insideGalaxy == false) || (isEmpty == false) || (withinRange == false));

input is
invalid

James Tam




6. Provide Clearly Marked Exits

do

insideGalaxy = isEmpty = withinRange = true;
System.out.print("Enter the destination row (0 — 9, -1 to pass): ");

row = Console.in.readInt();

if (row ==-1)

{
System.out.println("You have chosen not to move your ship.");
break;

}

System.out.print("Enter the destination column(0 — 9, -1 to pass): ");

column = Console.in.readInt();

} while ((insideGalaxy == false) || (isEmpty == false) || (withinRange == false)); t11

Allow the
user an
option to
quit

James Tam

6. Provide Clearly Marked Exits

Restoring defaults
* Getting back original settings

BUY/SELL e

CURRENT SHIP Ouress
CLRRENT SHIF VALLE 615,000
CREDITS 20,000
TOTAL CREDITS 635,000

P SHIPS COST

Heretic - 390,000

ags.00n | Voiecis

Faldari Mk Il
Fraij o 600,000

Fral] Mk u 600.000

Valncis = 190000

Wing Commander: Privateer 2 © Origin-EA
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Slide 35

ti1 Add the code to break out of the loop when the user selects -1
tamj, 12/4/2006



7. Provide Shortcuts

Experienced (power) users should be able to
perform frequently used operations quickly

* Type-ahead (entering input before the system is ready
for it)

* Navigation jumps
- e.g., going to window/location directly, and avoiding
intermediate nodes

* History systems
- WWW: ~60% of pages are revisits
- General: shortcuts for frequently used actions, shortcuts
for the user’s most recently used functions.

James Tam

7. Provide Shortcuts

Keyboard accelerators

[€] Microsoft PowerPoint - [hei_heuristics,
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Keyboard
accelerators for
menus

Customizable
toolbars and
palettes for
frequent actions

Split menu, with
recently used
fonts on top

Double-click
raises toolbar
dialog box

Double-click
raises object-
specific menu

PowerPoint © Microsoft

[E Microsoft PowerPoint - [M_heuristics]
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m

Scrolling controls
for page-sized
increments
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8. Deal With Errors In A Helpful And

People will make errors!

Errors we make
* Mistakes

*Slips

Positive Manner

Image and sound file from “The Simpson's” James Tam




8. Deal With Errors In A Helpful And
Positive Manner

Mistakes

« Arise from conscious deliberations that lead to an error instead of the
correct solution

= ] =R Oriine Coberston ¥ |
= 5.Doai With Errers In A Help =
Pty Cooce B

v Ostaons I
— I

Slips
» Unconscious behavior that gets misdirected en route to satisfying goal

* Shows up frequently in skilled behavior
- Usually due to inattention

« Often arises from similarities of actions

James Tam

Types Of Slips

1) Capture error
2) Description error
3) Loss of activation

4) Mode error

James Tam




Tvypes Of Slips: Capture Error

The frequently done activity “captures” the intended activity
* Occurs when common and rarer actions have same initial sequence
*“Force of habit results in the slip”

I Can“" = Are you sure E|@|E
believe T Delete file Do you wish to continue
pr‘essed spell check?

NO...

= Problem encountered

Do you wish to debug? Quitting program. do you
want to cave?

James Tam

Types Of Slips: Description Error

Intended action has much in common with others that are
possible
* Usually occurs when right and wrong objects physically near each other

*“Perform the right action but on the wrong object”
- e.g., Pour juice into coffee cup instead of glass

www.baddesigns.com

James Tam




Types Of Slips: Description Error (2)

(7

T8

[m
A
iy
>

s

\ Print

preview??

I
4"
|l

PowerPoint

W Db - Outhook Express

Outlook Express

Oops! | only meant for that
letter to only go to one person.
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Types Of Slips: Loss Of Activation

Loss of activation

* Forgetting what the goal is while undergoing the sequence of actions

- e.g., Start going to room and forget why you are going there
*“What the heck was I doing again?”

* Misordering a sequence

James Tam




Loss Of Activation
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Loss Of Activation (2)

Do« - S0

Contents Mwm|m| ~srowdl =]
Troubleshoot
What would you like to notes and
W handouts
Notes
E P Can I have more than
Select topic to display: one notes page for a
single side?
T est
About handouts » When I print my
Traubleshaot printing notes pages [ don't see
Set up the shide size for printing al the text that [
Make changes [0 noles pages entered into the notes
pane.

» 1formatted my notes
text, but the formatong
is not showing.

Handouts

b Twant a three-sides-
per-page handout but
without the ruled ines

for audience notes.

» 1 want to reprint onl/

James Tam




Loss Of Activation (3)

4 Microsoft PowerPol

Mo = SO

Help

Contents  Answer Wizard Im |

What would you like to

How do I print multiple slides per page?

Select tapic o display:

About Fandouts
Troubleshoot printing

[z ]

=10 x|

wShow Al &

Troubleshaot

notes and
handouts

&.Can [ have more than

Set up the dlide size for printing
Make changes to notes pages

one notes page for 3
Singic e

There is only one notes
page per side. The text
AutoFit feature in
Microsoft PowerPoint
helps in fitting text to
the placeholder by
reducing the font size If
there's text overfiow,
To verfy that AutoFit is
turned on, on the
Tools menu, cick
AutoComect Options.
On the AutoFormat as
you type tab, make
sure the autoFit body
text to phceholder
check box s selected.

James Tam

Loss Of Activation (4)
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Contents | Answer Wizard | [ndex |

= (Q Microsoh PowerPoint Help
B Microsoft PoweiPont Help Certer

< @ End-User Licanse Agreamant (Retail)

5 @ Geting Started

+) @ Microsoft PowerPant Accessibility

= @ Creating Presentations

= @ Running Presentations

=1 U Printing Presentations
@ About printing
(7] About printing in black and whita
[2) Setup e siide size for printng
[ Tum background printing on or of

i)
[ Pant hanl

2 Print reviewer Bomments

[#) Faxa presentation

[2] Troubleshoot printing

[#) Troubleshoot pnnting hidden slides
= @ Opening, Saving, and Converting Presenta
= @ Working on a Presentahon with Other Peog
= @ Working on the Web
= @ Installing and Customizng Microsol Power
o] Q Office and Windows Dasics
5 @ Handwiting and Speach Recognion
&) Q Secunty
4 @ Managng and Priniing Files
= @ Microsoft PowerPont VBA Language Refe
o) Q Language-Specific Features

= Show &ll :[

Print slides

If you are creating transparencies for an
overhead projector. use ths procedure
to print out your presentation on
transparent sheets. MOrosoft
PowerPoint automatically optimizes your
siides to print to the printer you have
selected — either biack and white or

coor.
1. Set up the side see for printing.
b How?

2. To see what your sides wil iook ke
when they prnt, on the File menu,
cick Print Preview, and make any
changes you want.

3. On the Print Preview toobar, in
the Print What box, cick Skdes.

4. Onﬂﬁmmtm,&k
print S

Note If you want to prnt out sidesin
coor, on the View menu, point 1o
Color|Grayscale, and then cick Color.
YOu must have a color prnter seiscted
as your defauk printer to preview the
siides in color in Print Preview.

James Tam
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+ @ Running Presentations
= ) Printing Presentations
@ About pnting
[7) About printing in black and white
2 Set up the slide size for printng
[# Tum background printing on or off
@
[# Print han
A printan
[2] Print notes p!
[# Print reviewsr Fomments
(9] Faxa prasentation
@ Troubleshoot prnting
[7) Troubleshoot piinting hidden slides
= @ Opening, Saving. and Converting Presenta
= @ Working on a Presentaion with Other Peof
= @ Warking on tha Wab
= @ Installing and Customizng M

h Power

~shon Al =]

Print slides

If you are creating transparencies for an
overhead projector, use ths procedure
to print out your presentation on
transparent sheets. Mcrosoft
PowerPoint automatically optimizes your
siides to print 1o the printer you have
selacted — either black and white or
cobor.

1. Set up the side sze for printing.
P How?

2. To see what your sides wil look ke
when they prnt, on the File menu,

cick Print Preview, and make any
changes you want.

3. On the Print Preview toobar, n
the Print What box, cick Shdes.

4. ©On the Print Preview toobar, dck
print &/

Note If you want to prnt out sides in
color, on the View menu, pont to

3 @ Office and Windows Basics

=) @ Handwriting and Speech Recognition

5 @ Security

= @ Managing and Priniing Files

= @ Microsoft PowerPont VBA Language Refe
s @ Language-Speciic Features

Color/ ¥ and then cick Color.
You must have a color printer selected
as your defauk printer to preview the
sides in color in Prnt Preview.

What was I trying
to do again???

James Tam




Types Of Slips: Mode Error

Mode errors
* People do actions in one mode thinking they are in another mode

Game is in
multiplayer mode
only (cannot load
saved games)

< =

Star Fleet Command
© Interplay
Productions

James Tam

Types Of Slips: Mode Error (2)

Mode errors
* People do actions in one mode thinking they are in another mode

Game is in single
and multiplayer
mode (can start
new campaigns or

load existing
< = games)

James Tam




Types Of Slips: Mode Error (3)

Mode errors
* People do actions in one mode thinking they are in another mode

In this mode it is
possible to load a
game

James Tam

Designing For Slips

General rules
* Prevent slips before they occur
* Detect and correct slips when they do occur
+ User correction through feedback and undo

Examples
* Capture errors
- One action captures another
- Allow actions to be undone rather than asking for confirmations
* Description errors
- Correct action on the wrong object
- Make objects look physically distinctive and/or far apart
* Loss of activation
- Forgot goal
- If system knows goal, make it explicit
- If not, allow person to see path taken or shorten steps
* Mode errors
- Mistake modes
- Have as few modes as possible (possibly none)
- Make modes highly visible

James Tam




Generic System Responses For Errors

General idea: Forcing functions

* Prevent / mitigate continuation of wrongful action
- e.g., range selection for dynamic queries

Gag
* Deals with errors by preventing the user from continuing
- e.g., cannot get past login screen until correct password entered

Warn
* Warn people that an unusual situation is occurring

* Better than nothing but when overused, becomes an irritant
- e.g., audible bell, alert box

James Tam

Generic System Responses For Errors (2)

Warning (probably needed)

Format £ Ax = = = :
Capacity: B WORKSPACE amg on Eam) on tami an Caniy
| |—]L-. 2GB :J (En) reptune.cp... thor.pe.cpe... ‘new.cpscu,.
File system
[FaT22 k|
Allpe ation unit sien
I |Det st adocation sze =
Wodume label
| workseacE
Forimat cpkicns
I Quidk Format £
I ik —!S TWﬂm:WnnMer&Auduamthudﬁ
o format the dsk, dick O, To quit, click CANCEL.
o | e |
Start close | ]

James Tam




Generic System Responses For Errors (3)

Warning (can get annoying, eventually the warning is

ignored)
\elete fie Cmlxll
[T E— I el
\elete fie Cmledl
(o ocetene It el

selete file _ Il

T ]
T x|
- T x|
- occicne P
- rrTE—— x|
- T x|
- rrTTE—— x|
- [qoeerene S
N =Io|x|

Are you sure?

James Tam

Generic System Responses For Errors (4)

Do nothing
« Illegal action just doesn’t do anything

* User must infer what happened
- e.g., enter letter into a numeric-only field (non-numeric key pressed are ignored)
- e.g., put a file icon on top of another file icon (returns it to original position)

Self-correct
* System guesses legal action and does it instead - but leads to a problem of

trust
- e.g., spelling checkers

Lets talk about it

* System initiates dialog with user with solution to the problem
- e.g., compile error brings up offending line in source code

James Tam




Generic System Responses For Errors (5)

Teach me
+ System asks user what the action was supposed to have meant
* Action then becomes a legal one

Error Handling In “The Good Ole Days”

Go T
ERRGR 153452

What is “error 157627?

mes Tam




Examples Of Error Handling From The “The Good
Ole Days”

Below is the full list of error codes with[out] a suitable
explanation to their meaning.

«103: Insufficient Free store
«105: Task Table Full

* 120: Argument line invalid or to long

*121: File is not an object module

*122: Invalid resident library during load
*202: Object in use

*203: Object already exists

*204: Directory not found

List of error codes from the AmigaDos OS James Tam

Errors: Don’t Make Things Seem Worse Than
They Really Are

Time fo
find
another
line of
work!

James Tam




Rules Of Thumb For Error Messages

1. Polite and non-intimidating
* Don’t make people feel stupid
— Try again, bonehead!

2. Understandable
¢ Error 25

3. Specific
* Cannot open this document
» Cannot open “chapter 5” because the application “Microsoft Word”
is not on your system

4. Helpful

» Cannot open “chapter 5” because the application “Microsoft Word”
is not on your system. Open it with “WordPad” instead?

James Tam

Examples Of Dealing With Errors In A Positive And
Helpful Manner

Prevent errors
* Try to make errors impossible
* Modern widgets: only “legal commands” selected, or “legal data” entered

. Fomm1 Pl E3
General | Attendees | Notes | Planner |
Date —W’her‘l
Start: [ 5.304M 2] [wed 5 14 /97 7 -
; All day
End [430PM 3] [Wed 5 A4/97 =
Month  Day ‘Year B T ED =
Descriplion S M TwW T F S
May |22 |1997 Smart Technoogy Ser|| 20 28 20 a0 A[2Pa |
Month  Day  Year 4 5 6 78 910
11 12 13HE 15 16 17
1819 20 21,22 23 24
May :I' 22 :I' 1997 :I' 25 26 27 28 23 30 31
123 4856 7|
(G Where:

Provide reasonableness checks on input data

* On entering order for office supplies
- 5000 pencils is an unusually large order. Do you really want to order that many?

James Tam




I’d Rather Deal With The Any Key Instead!

ersion 1,10 ADI
Phoenix Technologles Litds
Dell Computer Corponaii

Picture courtesy of James Tam: An error message from a Dell desktop computer

James Tam

Examples Of Bad Error Messages (2)

Could not fully start the application because a
pointer was nil when it should not have been

Adobe's ImageReady

Copy Profile Error x|

0 The operation completed successully.

ok |

Microsoft's NT Operating System

James Tam




Examples Of Bad Error Messages (3)

Microzoft Data Link E Microsoft Access E

& Unexpected Enar. Please investigate. &

Ja |

Outlook Express |

& There wasz an ermor opening thiz meszage.

An eror has occurred.

James Tam

Examples Of Bad Error Messages (4)

Services o Canada

Home | Search | FAQs | Downbeads | Mewsgroups | Contact Us | Frangais send @ | prie & | veip @

Error Message: Your Password Must Be at Least 18770 Characters and Cannot Repeat Any of
Your Previous 30689 Passwords (Q276304)

The information in this article spplies to:

» Microsoft Windows versions 2000 , 2000 SP1 , Professional
» Microsoft Windows versions 2000, 2000 SP1, Server
o Microsoft Windows versions 2000 , 2000 SP1, Advanced Sarver

SYMPTOMS

If you log on to an MIT realm, press CTRL+ALT+DELETE, click Change Password , type your existing MIT password, and then
type a new, simple password that does not pass the dictonary check in Kadmind, you may receive the following error
message:

Note that the number of required characters changes from 17,145 to 18,770 with the installation of SPL.

NOTE : This is not a common case; it occurs only when you configure Windows 2000 to authenticate against an MIT Kerberos
domain.

k|

Microsoft help page? James Tam




Errors: Giving Away Too Much Information?

Performance Warning

A new MS-D0S resident program named "IN may decreaze your system's performance.
YWould you like to see mare information abaout thiz problem?

Windows 95 dialog box

James Tam

9. Provide Help

Help is not a replacement for bad design!

Volume 37:
A user's

Simple systems: guide fo...
* Walk up and use; minimal instructions

Most other systems:
* Feature rich
* Some users will want to become “experts” rather than “casual” users
* Intermediate users need reminding, plus a learning path (novice to
advanced)

James Tam




Documentation And How It’s Used

Many users do not read manuals
* Prefer to spend their time pursuing their task

* Paper manuals unavailable in many businesses!
- e.g. single copy locked away in system administrator’s office

Typical usage scenarios:

* Usually used when users are in some kind of panic, need immediate help

- Indicates need for online documentation, good search/lookup tools

- Online help can be specific to current context
» Sometimes used for quick reference

- Syntax of actions, possibilities...

- List of shortcuts ...

James Tam

Types Of Help

Reference Manuals

Reminders
e Reference cards
*Keyboard templates

Context-sensitive help
*Tool tips
* What’s this (Balloon help)
Wizards

Tips

James Tam




Traditional form of help

Detailed

Paper or online

o
Office2000

Reference Manuals

A Microsoft Word Help

[_[O] ]

Lonlentsl Answer Wizard Index I
1, Tl

2, Or choose keywords

[oction

3, Choose a kopic (20 found)

Repeat your last action

Use the Lotus MotesFlow Action menu
About outline view

Undo mistakes

Set the importance level far a message
Flag a message for follow up

Change the security level for
macro virus protection

1. Onthe Tools menu, paint to
Macro, and then click Security.

18] show me

2. Click the Security Level tab, and
then select the security level you
want to use.

Learn about using security levels.

Note If you are a macro
developer, you can learn about
how security levels and digital
signatures work together in
Microsoft Word.

Additional resources

James Tam

Traditional form of help
| RS

Detailed

Paper or online

°
Office 2000

Reference Manuals

elp [_[O]x]
L

& High. Only signed macros from trusted sources will be
allowed to run. Unsigned macros are automatically
disablzd,

" Medium. ¥ou can choose whether or not ko run
potentially unsafe macros,

" Low {not recommended). You are not protected from
potertially unsafe macros, Lise this sekting ony if you
have virus scanning software installed, or you are sure
all documents you open are safe.

-
nge the security level for

Iro virus protection

In the Tools menu, paint to

acro, and then click Security.

|| show me

lick the Security Level tab, and
en select the security level you
jant to use,

arn about using security levels,
jote If you are a macro
veloper, you can learn about
pw security levels and digital

lansturss work togsther in
icrosoft Word,

Hditional resources

Mo wirus scanner installed.

Caneel

1" [Flag o message For folow up ]|

James Tam




Reminders

Short reference cards

- Expert user who just wants to check facts

- Novice who wants to get overview of system’s capabilities

R N R L N Y Spacebar Cycle through Multi-Function Display ..... .F1
Select Weauul ’Gruup ..... . . Enter DISPLAYS
Chain-Fire/Group-Fire Toggle . ................ \ Radar Display (Normal/Full Screen/OFF) F2
Alpha Strike . . . ;i P Damage Display ... .. . F5
Add Weapon to Group 1-5. ............ Shift+1-5 HTAL (Head /Torso/Arms/ Legs)
Fire Group 1,2, 3 Num Lock, /. Me,-pad] Armar Damage Report 6
Fire Current Group ...................... : Enable/Disable/Save/HUD 1
Jettison Ammunition . Sihed S K Remove Cackpit U
Objectives/Briefing Summary F12
Cycle Through All Targets . . ........... T CAMERAS
Previous Target .............. P TargetView ...l F4
Target Nearest Enemy . ... ... == .E Rear View /
Target Friendly (Lancemate) F DownView ..., F8
Target Object Underneath Reticle . . 0 Weapon View ... F3
Inspect Targeted Object S Weapon View (Full Screen, After Launcm - F10
TG ORI, e . Ctrl+T
From “Mechwarrior 2: Mercenaries” © Microprose James Tam
.
Reminders (2)
Keyboard templates
- Shortcuts/syntactic meanings of keys: recognition vs. recall.
—— 3 |
DOWN
T 1]
JAMMER m m NEXT
w_ﬂmﬂ" DECOY | OR/OFF | mor tllli TADS
F " AMIGA™S
Keyboare
o
FIRE
¥ “m [ =
VOLEME MAF | ROTATE | STOF |ROTATE iEw
it il v el =
From “Gunship” © Microprose James Tam




Context-Sensitive Help

Tool tips

=L =
~Insert Chart ﬁ

What’s this (Windows) or Balloon help (Mac)

| | & [Tal == S lls=Au w -c.

Chart ?

Creates a chart by inserting a Microsoft Graph object.

working with
- Macintosh “balloon help™

- Microsoft “What’s this” he

brief help explaining wh

James Tam

Wizards

Presentation Conference Wizard E

&sk each person For the name of their computer or their
Internet address as it appears in this wizard on their
computer, Enter that information belaw,

enter ar au;
Computer name or Internet address:

show details il I

Connection information ;I Remove |

Cpen List, .. |

Finish S et |
a

Conneckion

@ Cancel < Back [dEwt = Einish I

James Tam




Tips
e Introduce advanced features

* Point out incorrect use

Change Awareness

+ What is change awareness

* Why iz it an important area of study
+ Issues in change awareness

* Future work

James Tam

5

* Advanced features

* Point out incorrect use

[

e
3 Textis too small

Some of the text in this
placeholder might be too small
for your audience to read.

® Change text to be at least
Chal = point

@ Ignore this styls rule for
this presentation only

+ What is change aware| @ Change style checker
options for all presentations

+ Why is it an important
Y i P ™ Dan't show me this tip
* Issues in change awar|  agan

+ Future work

James Tam




Conducting A Heuristic Evaluation

It’s a compromise between extensive style guides and
intuition-based inspections

Style guides Heuristic Inspections
evaluation

James Tam

Conducting A Heuristic Evaluation (2)

*Employ a small set of evaluators (3—5) examine interface
using heuristics as a structure

*Each person evaluates the system according to the
heuristics individually (~1 — 2 hours)

James Tam




Conducting A Heuristic Evaluation (3)

*After this bring the evaluators together to
pool/compare their results

i
1

James Tam

Conducting A Heuristic Evaluation (4)

Benefits of group evaluations

*Single evaluator only catches ~35% of usability problems
* 5 evaluators catch ~75%

100%
s
83
s l:; 50%
53
& 25%
0%
o] 5 10 15

Number of Evaluators

Statistics from “Usability Engineering” by Jakob Nielsen James Tam




Heuristic Evaluations: Who Should/Could

Conduct Them
Interface experts End users
s bre
y €O
X7/
EVRL®

Software development team

Heuristic Evaluations: Types Of Systems
To Evaluate

Low fidelity paper prototypes e

BT G i, s 555

Medium fidelity prototypes

Completed systems

mes Tam




You Now Know

Nine principles of design
* Simple and natural dialog
* Speak the user’s language
* Minimize user’s memory load
*Be consistent
* Provide feedback
*Provide clearly marked exits
* Provide shortcuts
* Deal with errors in a positive manner
*Provide help

James Tam

You Now Know (2)

Heuristic evaluation

* Principles can be used to systematically inspect the interface for usability
problems

James Tam




Goals:

Methods:

Products:

Interface Design And Usability Engineering

Articulate:
*Who (users)
*What (tasks)

Brainstorm
designs

Task
centered
system

centered
design

Evaluate

Participatoi
interaction

Task
scenario
walk-

through

Representation
& metaphors

low fidelity
prototyping
ethods

User and
task
descriptions

Throw-away
paper
prototypes

This diagram is a variation of the one presented by Saul Greenberg

Refined
designs

Psych, User,
Representationg
and metaphors

Graphical
screen design

Interface
guidelines

high fidelity
prototyping
methods

Completed
designs

Testable
prototypes

Alphal/beta
systems or

comp
specification

James Tam




